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Abstract

:

Iron (Fe) is a micronutrient that can be toxic at elevated concentrations, prompting its significance in frequent environmental monitoring. Typically analyzed using methods such as FAAS, ICP-OES and ICP-MS, the challenge of expensive instrumentation operated only in the laboratory presents a barrier for rapid and frequent testing. This study aimed to develop a silica-based smartphone-assisted on-site method for rapid detection of Fe in water using ImageJ software. Suitable conditions, including reagents and a color intensity measurement tool, were optimized for this method. Figures of merit such as detection limit, accuracy and precision were determined. The results showed that adding polyacrylic acid to detection points for silica worsened the results, in contrast to results for paper devices. It was also found that, on ImageJ, it is best to use an integrated density tool to measure color intensity, contrary to the previously reported mean gray tool. Results showed a limit of detection of 0.2 ng, a limit of quantification of 0.6 ng, a linear range of 0.6 ng to 4.5 ng and RSD of <20%. This method is therefore an alternative in field pre-testing and screening. Future studies include application of this method in the field with real samples and in the analysis of other metals.






Keywords:


iron detection; rapid testing; toxic metals; ImageJ












1. Introduction


The poisoning of communities and their livestock has been reported in many instances after drinking groundwater laden with toxic levels of specific metals/metalloids, especially arsenic, lead, iron and chromium [1,2,3,4]. Consequently, it is important to monitor these elements in the environment, and this is predominantly done through analytical chemistry methods.



Analytical chemistry methods are an important part of everyday life, including areas such as medical diagnostics, product development, quality control and environmental monitoring [5,6]. The ability to carry out tests and analyses in and out of the laboratory is a big part of informed decision making that in many cases can be life-saving [7,8].



Currently, the detection of metals in various matrices is done through Inductively Coupled Plasma Mass Spectrometry (ICP-MS), Inductively Coupled Plasma Optical Emission Spectrometry and Atomic Absorption Spectroscopy (AAS), among others. These methods have low detection limits, good sample throughput and are a reliable way of analysis in the laboratory [9,10,11]. However, the cost of using these can be very high, especially in poorly resourced laboratories in developing countries. Cate [12] notes that the cost of these instruments can exceed USD150 for just one sample. With estimated purchase costs ranging from USD30,000 to USD200,000, these instruments are not only expensive to acquire but also expensive to maintain, with single parts costing thousands of dollars. Transportation and sample processing further drive up the costs of testing with these instruments [13]. The turnaround time for using such instruments may range from a couple of weeks to a few months, depending on how far samples have to be transported [9,14,15,16,17]. However, in environmental monitoring, there is a need for high frequency testing to capture what is happening in or near real time [14,17]. This means there is a need to increase the rapidity of testing. The current methods of analysis can also be expensive to operate, as significant amounts of reagents and gases are used and highly skilled personnel are required to operate. These challenges increase the turnaround time of using laboratory instruments and have significant implications on accessibility, especially for developing countries.



In recent years, there has been a growing interest in improving environmental monitoring through lab-on-a-chip and point-of-need devices [9,14,15,16,17,18,19]. Such devices have been available since the 1990s and researchers have been advancing on their construction and development [20]. Point-of-need devices can use a micro-liter (or even lower) level of a solution of analyte and reagents [12,21,22]. They can be rapid in detection and allow for analysis to be carried out at locations outside the laboratory [23,24]. Most have a designated point of introducing a solution, a pre-treatment zone and a detection zone [23,25]. These zones are usually connected by small channels that have the attributes of driving solutions without the need for an external driver such as gas (e.g., capillary movement in paper devices) [25]. Some of the substrates commonly used in the construction of point-of-need devices include paper, carbon, alumina and silica [26,27,28]. The method of detection may be electrochemical, chemiluminescent or colorimetric, among many others [26,29].



Iron (Fe) is ubiquitous, naturally occurring and the fourth most common element in the earth’s crust [30]. It is also one of the most significant elements for its effect on human physiology and the environment [31,32]. Occupational exposure of Fe has been found to be carcinogenic in Fe and steel founding and categorized in Group 1 (cancer causing substances) of the International Agency for Research on Cancer (IARC) [33]. It has been reported to specifically affect the human lungs [34]. As a micronutrient, Fe is the major component in the hemoglobin molecule that helps to transport oxygen in the body [35]. Fe at high concentrations in the environment has been reported to pollute underground water sources [36]. This poses a threat as water reserves are said to be steadily dwindling, globally [37]. Additionally, Fe plays a major role in the release and attenuation of toxic elements such as arsenic [38]. Therefore, the rapid detection of this metal in the environment is important.



The aim of this paper was, therefore, to develop a new rapid method of Fe analysis. This paper specifically explores silica as a substrate for out-of-the-lab Fe analysis in water with the assistance of a smartphone.




2. Materials and Methods


2.1. Chemicals and Materials


Fe (1000 ppm) AAS standard solution in 0.5 N Nitric acid purchased from Rochelle Chemicals (Johannesburg, South Africa) was used, Hydroxylamine Hydrochloride (99%) and 1,10-phenanthroline hydrate (chemically pure) were also purchased from Rochelle Chemicals, Johannesburg, South Africa. Poly (acrylic acid) solution (35% w/v. in water) was purchased from Merck KGaA, Darmstadt, Germany, and for the silica plates, TLC silica gel 60 F254 on aluminum sheets (5 × 10 cm) was purchased from Merck KGaA, Darmstadt, Germany. TraceCERT CRM Fe in water (ISO/IEC 17025) was also purchased from Merck KGaA, Darmstadt, Germany. The micropipette used was the MicroPette Autoclavable single channel pipettor manufacture by DLab Scientific Co., LTD (Beijing, China). The smartphone used in this study was an iPhone 11 Pro® manufactured by Apple Inc. (Cupertino, CA, USA).




2.2. Standards Preparations


Fe calibration standards were prepared in concentrations ranging from 0 to 50 mg/L of Fe by pipetting out 1.0, 1.5, 2.0, 2.5, 3.0, 3.5, 4 and 5 mL from the 1000 ppm stock solution into 100 mL volumetric flasks. Then 2 mL of hydroxylamine hydroxide solution (100 g/L) was added to each standard in order to convert all Fe3+ to Fe2+. The reason for this was because the 1,10-phenanthroline only reacts with ferrous iron (Fe2+) and not ferric iron (Fe3+). A 5.2 g/L 1,10-phenathroline solution was also prepared by dissolving 0.5217 g in 100 mL of water.




2.3. Fabrication on Silica Plate


On the TLC silica plate, circles of 5 mm diameter were drawn using lead pencil representing detection points for the prior prepared standards. Each prepared Fe standard solution was spotted on 3 detection points (circles). Two 0.5 µL aliquots of 1,10-phenanthroline were deposited on these detection points in order not to flood the detection point with a big volume. The plate was allowed to dry before each deposition. A blank detection point was also treated the same way as the ones for the standards. In order to determine whether polyacrylic acid would immobilize the resulting ferroin complex, as studied by Mentele et al. [21] on another silica plate, the same steps were followed then polyacrylic acid was added after the 1,10-phenanthroline. The silica plate was then ready for analyte deposition.




2.4. Fe Detection


After depositing all the reagents on the plates, the prepared standards were deposited (0.3 µL per standard) using a micropipette in designated detection points. This was done in triplicate. A blank and a standard reference material (TraceCERT CRM Fe in water) were also included by spotting them on the plate, also at a volume of 0.3 µL. In another experiment, the effect of the amount of Fe deposited to the same detection point was explored. To each detection point the same calibration standard was added (in 0.3 µL aliquots) once, twice and three times, with the plate’s image captured after each addition. This was done in order to capture the change in color intensity with double and triple spotting. The images were captured using a smartphone, through the camera and by scanning. The images were then transferred to a laptop and processed using ImageJ software (version 1.53e).




2.5. Image Processing


Images of the silica plate after color development were captured using an iPhone 11 Pro® in wide camera mode, aperture f/1.8, 26 mm, 12 MP, 3024 × 4032. The captured images were transferred to a laptop to be processed using a color intensity measuring software. The image software used was ImageJ, a public domain software developed by the National Institute of Health (US) [39]. For use with this software, all images had to be converted to JPEG format, including the scans. Upon being loaded on the software, images automatically opened and the detection points presented as orange spots against a white background. Images were then inverted (Edit > Invert) to negatives such that the background was turned black, thereby measuring zero in color intensity as done in similar studies [21,40]. Un-inverted images were also used for comparison and the data from these were log transformed before plotting. The image color contrast on the software was optimized to 156–252 (Image > Adjust > Contrast) which resulted in the best image. This was in contrast to the method color thresholding on ImageJ as used in previous studies [40]. Color intensity was measured in mean gray intensity and integrated density using the “Analyze” (Analyze > Measure or ctrl M) function. Mean gray is the sum of gray values of all pixels divided by the number of pixels, while integrated density is the product of the area of selection and the mean gray value [21]. That is, mean gray measures values within a selection as they are and integrated density tries to correct for the area of the selection. The measured color intensities were then plotted against the concentrations of the calibration standards.




2.6. Box Enclosure


To study the effect of light and shadows, images of the plates were captured in and outside of an enclosure. For the first experiment, the plates were photographed in an enclosed box (13 × 11 × 20 cm) using the smartphone. An incision was made on one surface of the box through which the smartphone camera lens captured the plates. The pictures were captured with the flashlight on. For the second experiment, the image was captured while outside an enclosure and just on a desktop. Images were captured using both photography and scanning with the smartphone. The images were then uploaded for image processing. This is similar to other studies of smartphone-assisted detections [41,42].





3. Results and Discussion


3.1. Color Development on Silica Plate


A bright orange color developed upon introducing samples and reagents to the prepared silica, showing the formation of a ferroin complex from the reaction of Fe and 1,10-phenanthroline. The samples that were additionally treated with polyacrylic acid in order to immobilize the complex resulted in poor color development. This was in contrast to the effect of polyacrylic acid in paper substrate experiments, where its addition improved the color development [21,40]. Figure 1 shows the images of spotting on the silica plate where polyacrylic acid was added and when it was not. Polyacrylic acid is said to have low mobility, particularly on paper [43]. It is a weak anion, making it highly mobile on silica substrate [5]. This explains its failure to immobilize ferroin complex on silica.




3.2. Results of Image Processing


Although image processing methodology from the literature was followed (where paper was the substrate) [21,40], results obtained in this study showed that settings on the software must be tailored to the specific substrate. Settings used for paper substrate were not suitable for silica substrate. Figure 2 shows the results of the silica plate with color thresholding, completed following procedures by Mentele et al. [21]. Contrary to when paper is used, it was observed that this method leads to high background noise and is not suitable for silica substrate (Figure 2b). A better image was obtained from manually adjusting the color contrast (Figure 2c) with much of the background noise eliminated. The best image resulted from setting the color contrast to “Auto”, i.e., allowing the software to correct the color contrast and then optimizing it (Figure 2d). Using this setting, the background noise was successfully reduced. This was true for both inverted and un-inverted images. The background color intensity was measured against the set concentration of zero as a blank was established. In the inverted images, the typically orange complex appeared as a luminescent blue against a black background.



While other studies predominantly inverted all images before color intensity readings [9,40], this work explored both inverted and un-inverted images and measure color intensities as presented in Figure 3. The linearity of the method was determined and observed to not go beyond an Fe amount of 4.5 ng (15 mg/L). As observed in Figure 3, both inverted and un-inverted images yielded linear graphs with a relatively good co-efficient of determination (R2), as high as 0.9969 and 0.9984, respectively. Un-inverted images yielded better linearity after being log transformed, while such a transformation made the inverted results worse. For both types of images, mean gray seemed to be a better tool of color intensity measurement, which is consistent with previous reports for similar studies [12,21]. This is investigated in detail and discussed in Section 3.4 (Color Intensity Measurements). These results showed that images can still give good results without being inverted first.




3.3. Box Enclosure


The effect of a box enclosure is presented in Table 1. The box enclosure experiment explored the effect of light and shadows on the captured images and, consequently, on the measured color intensity. From the 10 measurements done, the coefficients of determination (R2) were calculated and there was a notable difference between images captured by photography in an enclosed box and images scanned without the enclosure. From Table 1, it was observed that images from the enclosed box resulted in poor R2 values (0.709–0.859) compared to those captured from tabletop scanning (0.976–0.995). The use of an enclosure to capture images in colorimetric detection of toxic metals has been reported with positive outcomes [29,41,42]; however, some studies yielded have successfully used smartphone in colorimetric detection without an enclosure [44,45,46]. Other studies on smartphone-based colorimetric detection methods have also reported the effect of ambient light and presented their suggested solutions. For instance, one study attached a phone cover-like encloser on the smartphone lens to house the colorimetric device in order to minimize ambient light during image capturing [47]. In another study, instead of an encloser, an application called Colourine was used, which turns the background into a constant and thereby accounts for light interference in the measured color intensity [48]. Practically, in the case of field testing, the less bulky the device, the more portable it will be and, ultimately, the better.



It is clear that scanning produced better precision for analysis based on the improved R2 values. This was attributed to how the scanning application automatically adjusts lighting to eliminate shadows on the silica plate. A box enclosure was therefore not needed for this device.




3.4. Color Intensity Measurements


The color intensity of the ferroin complex was measured in both mean gray and integrated density. Results show that both measurements successfully measured color intensity on silica substrate. Table 1 shows R2 values calculated from calibration of Fe color intensity measurements in mean gray and integrated density. The average for mean gray measurements was 0.9752, while for integrated density measurements it was 0.9867. While in Figure 3 mean gray appeared to be a better tool of measurement, results of 10 experiments show a statistical difference between the measurement tools (Student’s t test, p = 0.018), indicating that measurements are generally better done in integrated density. In other studies, mean gray has been the choice of measurement when using this software due to the accurate results it yields [19,49,50,51,52,53,54,55], while not much is reflected in the literature regarding integrated density as a color intensity measurement tool. Typically, integrated density takes into account the area of the selection for calculations. This way, if only a portion of the drop reaches the detection point, the area of the color development is used to correct for the calculated intensity.



A trend was also observed where images from the box enclosure (higher background noise) were statistically best measured in mean gray, while those from the tabletop scan (lower background noise) were best measured in integrated density (Table 1). According to the literature [39,56], integrated density captures bright and dim colors more accurately, while mean gray “corrects” the dim colors to be brighter and the brighter colors to be dimmer [39,56]. Essentially, while integrated density corrects for area, mean gray corrects for brightness.




3.5. Effect of Amount Deposited


The effect of spotting detection points (in this case repeated depositions of a concentration of 5 mg/L in 0.3 µL aliquots) was assessed to determine if this would improve the outcome of the method. Table 2 shows that going beyond one deposit resulted in deviation from linear regression, signified by decreasing R2 values. The single, double and triple deposits of the Fe standards per detection point yielded R2 values of 0.9984, 0.9576 and 0.8829, respectively. For a concentration of 5 mg/L, the amount of Fe in mass per deposit was 1.5 ng. Therefore, a second deposit would raise the amount of Fe to 3.0 ng and a third deposit to 4.5 ng. This explains the increase in color intensity with each additional deposit. Since the maximum of the linear range was determined as 15 mg/L (4.5 ng), adding more of this standard to the detection points increased the amount of Fe on the detection points. In atomic absorption, limitation to Beer’s Law (relationship between absorbance and concentration) can be caused by high concentrations as crowded atoms/molecules/ions diminish the absorptivity of one another [6]. In this study, it is suspected that the crowding of atoms/ions diminished the color intensification.



According to the stoichiometry of the reaction (Equation (1)) between Fe and 1,10-phenanthroline, a higher Fe amount meant more Fe moles for limited binding sides on 1,10-phenanthroline. Consequently, at some point, increased Fe amounts did not increase the ferroin complex. It is therefore not only convenient to deposit once but yields better results.


Fe2+(aq) + 3phen → [Fe(phen)3]2+(aq)



(1)








3.6. Method Validation


To validate the method, figures of merit were determined and the results are presented in Table 3 below. The relative standard deviation (RSD) was found to be under 5% in all test samples. A good analytical method for metal analysis is generally considered to have an RSD of less than 20% [57,58,59]. However, much higher values are accepted for spotting techniques particularly for thin layer chromatography plates [60,61].



The accuracy of this method was tested using certified reference material TraceCERT® CRM Fe in water. The results of Fe analysis of the CRM are displayed in Table 4. Results show that this method was accurate as the mean from the silica device analysis of the of CRM was statistically not different from the certified value at a 95% confidence level (p > 0.05). (Table 4). The Fe concentration in the CRM was measured to be 20.09 ± 0.17 mg/L using FAAS and 20.73 ± 1.25 mg/L using the silica device.



The limit of detection and limit of quantification were determined as 0.2 ng and 0.6 ng of Fe, respectively. This LOD is less than that previously reported using the same method on a paper device [22]. A similar study also reported accuracy within a 95% confidence level in detection of Fe in river sediments, concluding such a method would be suitable as a green alternative option for field testing [62].





4. Conclusions


The development and method validation of a new smartphone-assisted method was successfully carried out, yielding an LOD of 0.2 ng, LOQ of 0.6 ng and a good precision (RSD of <20%) for a spotting technique. The accuracy of the developed method was compared to FAAS using a standard reference material and no statistical difference was found at a 95% confidence level. It was determined that for this method, a linear range of 0.2–4.5 ng of Fe was applicable. The developed method proved more sensitive than similar methods in the literature for paper substrate according to compared LODs. This study also concludes that, contrary to other substrates (specifically paper), the ferroin complex was not immobilized by polyacrylic acid and, in fact, yielded worse results because of it. Therefore, the specific substrate is important in determining the reagents to be used for Fe detection in such devices. In processing the images on ImageJ, the color thresholding function resulted in poorer results. This was in contrast to what has been reported in similar studies with paper as a substrate. Therefore, for silica substrate, adjusting the color contrast by setting it to 156–252 (Image > Adjust > Contrast) yielded the best results. Both inverted and un-inverted images yielded good results, with inverted results being slightly better. While most colorimetric studies that have used ImageJ software report color intensity in mean gray, this study not only explored integrated density as an alternative measuring tool but, in fact, concludes that according to the results, it statistically showed better precision of the method. We plan to apply the current method on-site to real environmental samples and use similar method development strategies for other metals of concern.
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Figure 1. Spotting of iron on a silica plate device showing color development of the orange ferroin complex with polyacrylic acid (top) and without polyacrylic acid (bottom). 






Figure 1. Spotting of iron on a silica plate device showing color development of the orange ferroin complex with polyacrylic acid (top) and without polyacrylic acid (bottom).



[image: Applsci 14 03651 g001]







[image: Applsci 14 03651 g002] 





Figure 2. Images of the silica device for color detection of Fe: (a) photographed image before processing; (b) image after inverting and color thresholding; (c) image after inverting and manual contrast adjustment instead of color thresholding; and (d) image after automatic contrast adjustment. 
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Figure 3. Calibration curves of Fe using the silica-based device showing: (a) color intensity of un-inverted images of detection points measured in mean gray; (b) color intensity of un-inverted images of detection points measured in integrated density; (c) color intensity of inverted images of detection points measured in mean gray; and (d) color intensity of inverted images of detection points measured in integrated density. 
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Table 1. Correlation coefficients of calibration curves in colorimetric detection of Fe using a silica device measured in ImageJ through mean gray and integrated density.
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Box Enclosed

	
Tabletop Scan




	
Mean Gray

	
Integrated

Density

	
Mean Gray

	
Integrated

Density






	
0.772

	
0.733

	
0.967

	
0.981




	
0.822

	
0.731

	
0.963

	
0.992




	
0.777

	
0.772

	
0.947

	
0.982




	
0.864

	
0.815

	
0.982

	
0.987




	
0.864

	
0.815

	
0.982

	
0.987




	
0.787

	
0.744

	
0.957

	
0.976




	
0.862

	
0.756

	
0.997

	
0.995




	
0.823

	
0.727

	
0.997

	
0.995




	
0.795

	
0.709

	
0.990

	
0.994




	
0.881

	
0.859

	
0.970

	
0.978




	
0.8247

	
0.7661

	
0.9752

	
0.9867











 





Table 2. Effect of increasing the number of deposits per detection point showing coefficients of determination (R2) and calibration equations (each deposit was 0.3 µL of standard).
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	No. of Deposits
	R2
	Calibration Equation





	1
	0.9984
	y = 4.91x + 0.91



	2
	0.9576
	y = 7.43x + 9.45



	3
	0.8829
	y = 8.41x + 18.0










 





Table 3. Relative Standard Deviation of Fe standards (5 mg/L, 10 mg/L and 15 mg/L) in %.
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	Fe Amount (ng)
	RSD (%)





	1.5
	18.6



	3.0
	7.36



	4.5
	12.7







N = 10.













 





Table 4. Certified reference material (TraceCERT® CRM Iron in water (ISO/IEC 17025)) concentration determination with silica device compared to AAS analysis in mg/L.
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